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The “3D Picture Trick” - by Daniel Brown, Adobe Systems Inc.
www.adobeevangelists.com

Inspired completely by Patrick Siemer - www.tapeandglue.com 

Adobe After Effects 

There are a multitude of effects within the aptly-named After Effects. Particle simluations, depth tricks, 3-D 
motion, procedural animations of every kind imaginable. Yet, one is reminded of a simple fact - a great use 
of simple technology can steal the show over lightning and laser cannons, explosions and “Matrixware”. 

This tip consistently gets more oohs and aahs than just about anything else in After Effects. Why? Because 
it reminds us of the point above - the music isn’t in the piano and creativity isn’t in the box with the soft-
ware. Hopefully, this will give you some ideas for thinking “outside the software box”.
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Okay, fair warning… Like so many things, this trick looks easier than it is. That is to say, the me-
chanics of the effect are fairly easy – you take a photograph, cut out the people and place each of 
them on their own layer in Photoshop, bring that layered Photoshop document into After Effects, 
stagger the layers in 3-D, then animate a camera around it. But there are many steps along the 
way that can ruin the effect. Here are some guidelines to keep in mind…

1. Pictures with several levels of depth – but not too many – work best. A bad example is a pho-
tograph of a painting framed on a wall. There’s just not a lot of depth there. On the opposite end 
of the spectrum is a picket fence with 75 levels of depth, one for each picket. If you want to spend 
the time to isolate each of the pickets, that’s up to you. (For the record, I would use one picket and 
duplicate it.) An image with 5-10 layers is probably a good range.

2. Since part of the work to be done involves restoring the background behind the people in the 
scene, your cloning/rubber stamp skills will be put to the test. Part of what makes this effect be-
lievable is how well the background behind the people is reconstructed. In some areas, you may 
not have a background to copy from so you’ll need an artistic eye. (Another way of saying this is 
you’ll quickly learn how much you can get away with. Unlike a still image, your audience will be 
somewhat forgiving because the image is in motion.)

With those two caveats out of the way, this is an amazing effect and not terribly complicated to 
set up.

First thing’s first. You’ll need an image. Older images seem to work best (probably because your 
eye doesn’t expect to see an old image in 3-D), but just about any image will do. You’ll want this 
image to be larger than your final output format (such as video tape or DVD) because you’ll need 
extra image data for panning and zooming. (This image is 1988 x 1381 so I can zoom in to a little 
more than double actual size and still be at less than 1:1.) 

Okay, now comes the tough stuff…
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Step 1 – Analyze your image and plan how you are going to 
separate the elements from the background. (Come to think if 
it, this is good advice for any Photoshop project. Ponder it for a 
while, take a walk, get away from the computer, then come back. 
It works wonders.)

Open the image in Photoshop. Now, before you start selecting 
anything, be clear on what you want to isolate and think about 
the structure of the image. A good example in this image is the 
woman on the right. She has her hand on a chair. Now, while the 
chair and table are *technically* behind her, having them move 
independently of her would be tricky to achieve. So, I established 
early on that she and the table would move together. Since she’s 
not that far in front of the table, the perspective should be okay.

 When you’re ready, begin selecting elements in the image, and 
remember that Command-J  or CTRL-J will “Jump” a selection to 
a new layer. 

(Note that I didn’t go into long discussions about how to select 
objects. That, my dear readers, is an art form unto itself and be-
yond the scope of this tutorial.)

Step 2 – With each of the elements in their own layers, it’s time 
to clone in the background. (Just because you’ve separated el-
ements into their own layers doesn’t mean they’re gone from 
the background.) This part is the most challenging and will be 
different with every image you use. General tips are to watch for 
“fringes” when you cut something dark out of a light background. 
You’ll often get a light halo around black edges, and dark halos 
around lighter areas. You can get rid of this pretty easily using the 
dodge or burn tool (depending on whether you need something 
darker or lighter). This will retain most of the detail while get-
ting rid of the unwanted fringing. For a dark halo, set the Dodge 
tool (looks like a black lollipop) to “Shadows” and play with the 
“range” value. For a light halo, set the Burn Tool (looks like a hand 
making an “O”) to “Highlights”. In each case, stick with the outer 
edges of the layer.

Step 3 – This is actually a 2a but, while it’s a lofty goal to com-
pletely remove each element from the background and fill in 
the result as much as possible, keep in mind that your elements 
probably won’t be moving very far. Grab the move tool occasion-
ally and slide your layer around a few pixels left and right, and 
maybe up and down.

A sure giveaway that you’ve cut something out of a 
background. The dark edges around her collar can be 
treated with the dodge tool set for shadows.
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Step 4 – When you’re convinced you’ve got all the pieces the way 
you want, save the file as a PSD.

Step 5 – If you don’t already have After Effects, go purchase a 
copy. Then, launch After Effects.

Step 6 – Import your PSD file. BUT! Before you click OK in the 
import dialog box, make SURE you choose to import the file as 
a Composition. Doing this will import all of the layers at once, 
and create a “comp” with the layers in the same position they oc-
cupied in Photoshop. (I’ve watched people who were unaware 
of the “As Composition” option and attempt to do this layer by 
layer… It’s not pretty.) For you lucky After Effects 6.0 owners, 
choose “Composition – Cropped Layers”. This will respect the 
actual size of the data within each of the layers.)

Step 7 – After Effects will import the individual layers from the 
PSD file, create a composition, and place of the layers in that com-
position in the same order, in the same position, and with the 
same naming convention used in the Photoshop document. 

You should now have two entries in your project window – A 
Composition and a folder, both named after the PSD file you 
imported. (The Composition and the folder both contain the 
layers from the Photoshop file. The Composition is the layers 
assembled as a stack, the folder is simply the individual layers 
contained in the Composition. Hence, the folder is more of a 
project organizational thing.)

Step 8 – Double-click the Composition to open it. You should see 
all of the layers in place. Note that After Effects retains Photoshop 
layer names. (LAST MINUTE UPDATE: After Effects 6 retains layer sets from 
Photoshop, retaining them as nested compositions.)

Step 9 – We need to enable 3-D for all of these layers. In the 3-
D column of the timeline, make sure all of the checkboxes are 
enabled. This step simply enables 3-D transformations on 2-D 
objects. Now we can rotate and/or position the objects in 3-D.

When you import the Photoshop file, make sure you 
choose to import it as a Composition.
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Step 10 - Okay, the good news is that all of the objects are in 
3-D. The bad news is that they’re on the same Z-plane. (A fancy 
way of saying that there’s no space between them front to back, 
essentially flat.) What we need to do is stagger them in Z-space 
to give them some depth.

To see this, switch to “Custom View” 1 option on the bottom of the 
composition window, which probably says “Active Camera” at the 
moment. (You can also switch views under the View menu, View 
> Switch 3D View > Custom View 1). Custom View 1 is essentially 
a camera positioned up and to the left of the composition. Switch 
to this view, and you should see something similar to this.

Note that though the elements have been isolated from each 
other, they are still on the same plane in space so you’re not get-
ting much in the way of perspective.

Step 11 – If you select all of the layers, and hit the “P”  key, After 
Effects will reveal the Position information for all of the layers. 
Notice that all of the layers currently have exactly the same po-
sition values for X,Y, and Z.(These are the three blue underlined 
values to the right of the word “Position”.) We’re going to focus 
mainly on the Z dimension.

Step 12 – For the purposes of this example, I’ll keep the numbers 
fairly simple. Starting with the Front Table (the topmost layer), the 
Z values for each layer are -320, -220, -120, -75, -60, -122, and the 
background should be at zero. Notice that these are all negative 
numbers (with the exception of zero of course). Type each of 
these numbers into the third column of blue numbers, the first 
two (X and Y) will remain the same.

Switching between different views, in this 
case choosing Custom View 1.

Adobe After Effects and Adobe Photoshop

The “3D Picture Trick”



6 7

Step 13 - You should now see - however subtly – that there is 
space between each of the layers. While it takes a bit of depth 
to do “real” 3-D, what we’re after here is a fairly subtle but ap-
preciable perspective change. You can get a feel for what this 
while you’re in “Custom View 1” by selecting the Camera Orbit 
Tool. (Appropriately enough, it’s an arrow orbiting a small sphere 
in the toolbox. You can get to it by hitting the “C” key. If you don’t 
see it at first, additional hits of the “C” key will step through the 
various camera tools.)

With the camera orbit tool selected, click and drag around in the 
composition window. If everything has been set up correctly, 
you should see all of the layers rotating in 3-D space. Naturally, if 
you rotate the layers too far, you’ll see the layers edge-on. This is 
not a good indicator of how this file will actually be used, which 
brings us to:

Step 14 – Understanding how a file like this will actually be used. 
While the camera orbit tool gives you a good feel for the fact that 
the layers are in 3-D, it’s not a very practical way of viewing the 
layers for the final product. In fact, the final rendered example has 
very little (if any) rotation of the camera at all. Most of the effect 
you’re seeing is panning and zooming, not rotating. You don’t 
need to rotate the scene very far to spoil the effect.

What we need now is a camera we can move over time. Under 
Layer > New > Camera, we’ll create a new camera, one that we 
can animate over time. In the New Camera dialog box, set the 
Angle of View to 75, and click OK (Ignore the other settings for 
now).

You should see a camera appear in the composition window 
pointing at your layers. (It’ll be disguised as a simply 3-D wire-
frame box with a large wireframe pyramid attached to the 
front.)

The same layers, ever so slightly staggered 
in 3-D space.
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Step 15 – Well, we’ve created a lovely camera, but currently we’re 
looking AT the camera rather than THROUGH the camera. In the 
pop-up menu at the bottom of the comp window (Or from the 
View Menu > Switch 3D View), we’ll switch from "Custom View 1" 
to “Camera 1”. Choosing this will show what Camera 1 is seeing.

Step 16 – From here, it’s all about animating the camera. The 
first thing I did is to zoom in on the woman in the center. Using 
the “Track Camera Z” tool (which will move the camera closer to 
or farther from the layers), I moved in close to the woman in the 
center. Then, using the Track Camera X,Y tool, I moved up slightly 
to center her face in the window. (Again, the “C” key will switch 
between the various Camera tools. The Camera X Y tool has ar-
rows up/down and left/right, the Camera Z tool has arrows facing 
toward you and away.)

Step 17 – This is where I want the camera to begin, so I clicked 
on the Camera 1 layer and hit the “P” key, which reveals all of the 
position information for the camera, and clicked the stopwatch 
to animate the position property (locking in the current values 
as the start of my animation.)

Step 18 – Moving to about 8 seconds down the timeline, I simply 
used the Track Camera tools again to position the camera back 
and a little to the left thereby centering all three women in the 
scene.

This is the start of the animation. The camera has been 
zoomed in and panned to center this woman in the 
frame.

This is the end of the animation. The camera has been 
zoomed back and positioned slightly to the left.
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Step 19 – The above is just fine if you’re doing very robotic 
moves, but most documentary films pan photos very organi-
cally. You “feel” the weight of the camera because of the way 
they move the image.

That step, that “make magical” switch (or at least part of it) is the 
“Easy Ease” function in After Effects. Essentially, it tells After Ef-
fects to take its time about getting the camera up to speed, and 
about slowing it down again once it has moved.

To achieve this, select both keyframes for the camera and choose 
Animation > Keyframe Assistant > Easy Ease. (Note that I took a 
bit of a shortcut here. If there were other keyframes before the 
first keyframe, or after the last keyframe, we’d want to be more 
selective about how we did the interpolation. Easy Ease essen-
tially means “ease gently into this keyframe, AND ease gently out 
of this keyframe”. In some cases, you may want to only ease into 
OR out of a keyframe, but not both. In those cases you would 
choose Ease in, or Ease out.)

Step 20 – “Season to taste” - Naturally, there are THOUSANDS of 
adjustments you could make to this. (i.e depth of field, manually 
repositioning elements in the scene to force more perspective, 
insert the resulting composition in another composition that 
pans the animation, auto-orienting the objects toward the cam-
era, and for that matter, this can extend into an entire animation 
mechanism.) but at its core, the beauty and elegance of this tip 
is its simplicity. Now, take this basic lessons and go make some-
thing cool!

A special thanks MUST go to Patrick Siemer whom, while prob-
ably not the originator of moving elements in 3-D, first showed 
the team how this could be done in After Effects. Thanks Patrick! 
(See Patrick’s work at http://www.tapeandglue.com )

Here, we’ve changed them to “Easy Ease” keyframes 
meaning that the camera will begin moving slowly, 
and then ease to a stop.

These are the two keyframes we’re modifying. Cur-
rently, they’re “Linear” keyframes, making them appear 
very robotic.
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